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2 Disclaimer 

The actual version of this product (document) is available as is. TEC-IT declines all warranties 
which go beyond applicable rights. The licensee (or reader) bears all risks that might take place 
during the use of the system (the documentation). TEC-IT and its contractual partners cannot be 
penalized for direct and indirect damages or losses (this includes non-restrictive, damages through 
loss of revenues, constriction in the exercise of business, loss of business information or any kind of 
commercial loss), which is caused by use or inability to use the product (documentation), although 
the possibility of such damage was pointed out by TEC-IT.  

 

 
We reserve all rights to this document and the information contained therein. Reproduction, 
use or disclosure to third parties without express authority is strictly forbidden. 
 

 
Für dieses Dokument und den darin dargestellten Gegenstand behalten wir uns alle Rechte 
vor. Vervielfältigung, Bekanntgabe an Dritte oder Verwendung außerhalb des vereinbarten 
Zweckes sind nicht gestattet. 
 

© 1998-2006  
TEC-IT Datenverarbeitung GmbH  
Wagnerstr. 6 

A-4400 Austria  
t.: +43 (0)7252 72720  
f.: +43 (0)7252 72720 77  
http://www.tec-it.com 
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3 Introduction 

3.1 About 

TEC-IT Barcode Studio is a tool for generating and printing barcodes. All common Linear, 2D and 
Composite symbologies are supported. 

You can adapt all barcode parameters to your needs, export the barcode to an image file (e.g. for 
using it in your artwork), copy the barcode to the clipboard or print it. 

If you have any questions, please contact our support: support@tec-it.com. 

TEC-IT Datenverarbeitung GmbH 
Wagnerstrasse 6 
AT-4400 Steyr 
AUSTRIA / EUROPE 

3.2 Supported Operating Systems 

� Windows XP 

� Windows 2000 

� Windows NT 4.x or higher 

� Windows Server 2003 

� Windows 98 (image dimensions are restricted to 1200 pixels width / height) 

� Windows ME (image dimensions are restricted to 1200 pixels width / height) 

3.3 Restrictions of the Demo-Version 

► In the demo version the barcode will be marked with a demo text. The barcode data itself will 
not be modified.  
To obtain a license key for the full version (without demo text) you can order Barcode 
Studio by using the online ordering service at http://www.tec-it.com/order. 
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4 Quick-Start 

4.1 Introduction 

This chapter will guide you through the most important functions of Barcode Studio by showing 
you how to create an EAN13 barcode. For more detailed explanation on the user interface and on 
the available functions and settings, please refer to the chapters 5 to 9. 

4.2 How to Create an EAN13 Barcode 

 
Figure 1: Quick-Start – Barcode Studio Main Window 

In order to create an EAN13 barcode, please perform the following steps: 

� Select the barcode type (symbology) – see section 4.2.1. 

� Enter the barcode data (see section 4.2.2). 

� Select the output resolution (see section 4.2.3). 

� Specify the barcode dimensions (see section 4.2.4). 

� Fine-tune the module width (see section 4.2.5). 

� Set font style and size (see section 4.2.6). 

 

� � 

� 

� 

� 

� 
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4.2.1 Select Barcode Type (Symbology) 

 
 

Select the barcode type (symbology) in �. Drop 
down the combo box and choose “EAN13”. 

Hint: If you pres the E key, the first entry starting 
with an “E” will be selected in the drop down list (in 
this case EAN13). 

 

To learn more about the selected barcode, click the 
“?” button. This will open an info page in your html 
browser. 

4.2.2 Enter Barcode Data 

After switching to the EAN13 symbology you have to enter the barcode data. The EAN13 symbo-
logy requires 12 digits (13 with check digit) for successfully generating a barcode. Since the current 
data (“123456”) has the wrong length Barcode Studio will inform you with the following error 
message: 

Error: Wrong number of input characters (12 chars needed)! 

 

 
 

Enter the data to be encoded in � or via the 
Barcode Data dialog. 

 
 

The Barcode Data dialog 	 can be opened by 
double-clicking on the barcode symbol (respective-
ly on the blue rectangle showing the error 
message). 

Edit the data within the text box or load the data 
from a text file (via the Load File… button). 

 

The barcode preview will be updated for every 
change of the input data. As soon as you have 
entered all twelve characters you will see the bar-
code on the left. 

If you have entered a wrong character (or the wrong number of characters), an error message will 
be displayed instead of the barcode. For a list of possible error messages, please refer to 0. 

► The 13
th
 digit in the resulting EAN13 barcode (in this case the digit “3”) is the check digit. 

This check digit will be calculated and inserted automatically. 

► If you do not enter 12 but 13 characters as barcode data, the check digit will be overridden. 
This is not recommended, unless you know the correct value for the digit. A wrong check 
digit may render the barcode unreadable! 

 

� 

� 
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4.2.3 Select Output Resolution 

 

The output resolution can be adjusted in �. Select one of the list entries 
or enter a custom dpi value. 

 

In this example the output resolution is changed to “300 dpi”. 

If you are planning to print the barcode on a laser printer you would 
most probably select a higher resolution (600 or 1200 dpi). 

If you want to create a barcode image for your web-page you could also 
use “Screen Res” or “72 dpi (BMP)” for exporting the image. 

 

Usually a higher barcode resolution leads to better barcode quality. 
When generating a barcode in a good to perfect quality it is very 
important to match the resolution of the output device (or the target 
application like PhotoShop).  

 

► When using the barcode image in pre-press applications take care to avoid any scaling or 
resizing of the generated barcode image. This may lead to inaccuracies and distortions 
rendering the barcode unusable. Generate the barcode image in exactly the resolution and 
size as required! 

4.2.4 Specify Barcode Dimensions 

Now enter the required barcode dimensions (Width, Height and Module Width). 

Most label or barcode specifications require specific barcode dimensions. For EAN13 the following 
dimensions are commonly used: 

Magnification 
factor 

Module width [mm] Width [mm] Height [mm] 

0.80 0.264 (SC0) 29.83 20.73 

1.00 0.330 (SC2) 37.29 25.91 

1.50 0.495 (SC6) 55.94 38.87 

2.00 0.660 (SC9) 74.58 51.82 

Table 1: EAN13 Dimensions (not complete) 

 
 

We use the magnification factor 1.00. 

 

Enter the width and the height in �. The appropriate module width will 
be calculated automatically. 

Please note, that the width may change slightly after the value has been 
entered. That is, because the physical symbol width is re-calculated for 
the output resolution (e.g. the 300 dpi). The barcode width will always 
be reduced to fit into an integral number of pixels. 

 

The barcode should now look like this. 

� 

� 

� 
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4.2.5 Fine-tune Module Width 

Yet the quality of the barcode is not perfect (see the Quality Watch at the top left of the Barcode 
Studio window): 

 

To optimize the barcode quality we recommend fine-tuning the module width. You can do this by 

� selecting “Optimize Resolution” (see Figure 1, �) or by 

� selecting “Pixels” as Unit. Then enter an integer value (and eliminate the decimal places). 

This will both lead to a “Perfect” barcode quality. 

4.2.6 Set Font Style and Size 

The font style and size can be set via the “Font and Colors” dialog (see section 7.2). You can open 
this dialog by pushing the Font and Colors… button (see Figure 1, �). 

This example uses a 10 pt Courier New font: 
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5 Using Barcodes in Other Applications 
(Exporting Barcodes) 

This chapter is a general instruction for using barcodes generated with Barcode Studio in other 
applications. A detailed explanation of the user interface and possible barcode settings can be 
found in the next chapter. 

5.1 General 

You can export the barcodes created in Barcode Studio as follows: 

� Copy the barcode to the clipboard (as image) and paste it into your application. 

� Export the barcode to an image file. 

� Export a series of barcode images (batch job). 

Before exporting the barcode you have to adjust the required image size: 

5.2 Adjust Image Size 

The size of the resulting barcode image can be controlled by changing the dimensions (width, 
height) and the output resolution (DPI) – see also section 6.6. These settings apply for all kinds of 
export operations. They should be adjusted prior to exporting the image. 

► If you have exported the barcode, do not resize the barcode image with image manipulation 
software (like Photoshop

®
)! The quality (and the readability) may be reduced! 

► Whenever possible, always create the barcode within barcode Studio in the required size 
and resolution to avoid resizing later on. 

5.2.1 Dimensions (Width, Height) 

The width and the height of the barcode are adjusted in the “Barcode Dimensions” toolbar. These 
dimensions match the size of the barcode preview in the design window. 

Unit Description 

Millimeter Measure the width and the height of the barcode in millimeters. 

The physical width (in pixels) can be calculated as follows:  
width (pixels) = width (mm) / 25.4 * resolution (dpi) 

Inch Measure the width and the height of the barcode in inches. 

The physical width (in pixels) can be calculated as follows:  
width (pixels) = width (inch) * resolution (dpi) 

Mils Measure the width and the height of the barcode in mils. 

The physical width (in pixels) can be calculated as follows:  
width (pixels) = width (mils) / 1000 * resolution (dpi) 

Pixel Measure the width and the height of the barcode in pixels. 

The width and the height are shown as physical (pixel) values. Basis for the displayed dimen-
sion is the size on the screen (in mm respectively in inch) and the adjusted resolution (dpi). 

5.2.2 Resolution (DPI) 

The resolution (dpi) defines the raster width for rasterizing the barcode image. 
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► The screen preview uses a resolution of 72, 96 or 120 dpi (depending on your monitor and 
the display settings for your operating system). If you want the exported barcode image to 
be the same size (in pixels) as the preview in Barcode Studio you will have to set the dpi 
value to “Screen Resolution”. 

► For increasing the detail of the barcode symbol you can increase its resolution. However, 
most applications (Microsoft Word

®
, web browsers, etc.) show the barcode image regardless 

of the adjusted dpi. They are using the default screen resolution instead.   
As a consequence a barcode image will be displayed enlarged when setting the output reso-
lution to a higher dpi value. Example: If your screen resolution is 96 dpi and if the exported 
image has a resolution of 300 dpi it will be displayed 3 times as large as in Barcode Studio. 

► Only some professional layout applications consider the adjusted dpi value. Most applicati-
ons will show (and print) the barcode image in the screen resolution. This leads to a different 
(enlarged) output size. 

► The dpi value can be stored for certain image formats only! For detailed information, please 
refer to Appendix C. 

 
Resolution (DPI) Description 

Screen Res Uses the actual screen resolution (either 72, 96 or 120 dpi).  
The image will be exported in exactly the same size as you see it in Barcode Studio. 

Note: Under Windows XP the screen resolution is adjusted in the Control Panel ► Display ► 
Settings ► Advanced ► General: Display / DPI Setting. 

Printer Res Uses the DPI setting of the currently selected printer driver.  
You can NOT use this resolution for exporting the barcode to an image file or for copying it to 
the clipboard! 

72 dpi (BMP) Creates the image with 72 dpi. 

Other Creates the image with the given dpi.  
Higher dpi values result in larger (and more detailed) image files. 

When exporting an image to a BMP or to PNG file the adjusted resolution (dpi) will not be stored 
within the image file. Only the formats JPG, TIF (and EMF) are capable of storing the resolution. 

5.2.3 Resolution and Readability 

5.2.3.1 Barcode Quality 

When exporting the barcode to a bitmap image (BMP, JPG, PNG, PCX, TIF) it must be converted 
from its internal resolution (high) to a graphical pixel resolution (low). During this process (raste-
rizing) the module width can vary due to rounding errors. 

When exporting a barcode to a vector based image format (EMF, EPS) or to the clipboard the 
internal representation of the barcode symbol allows a very high resolution (which is independent to 
the adjusted dpi). The dpi value is only used for scaling the whole symbol width to match the 
underlying dpi raster. 

Thus it is recommended to use vector based image formats (EMF, EPS) whenever possible. 
However, for certain applications (e.g. web applications) it is inevitable to use bitmap images. 

The readability of a barcode for the given size and output resolution can be estimated using the 
Quality Watch (see section 6.1, �). For receiving the best readability for the barcode, please enable 
“Optimize Resolution”. 

5.2.3.2 Module Width 

The minimum module with should always be 0.19 mm. In other words: When using a module width 
of 1 pixel the printing resolution has to be set to 133 dpi or less. Using 2 pixels as module width the 
resolution should be set to 266 dpi maximum. 
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5.3 Copy to Clipboard 

To copy the current barcode to the clipboard select Copy to Clipboard from the menu (located in the 
Edit submenu), from the pop-up menu (right-click on the barcode), or from the button toolbar. You 
can also press the keyboard shortcut Ctrl+C. 

Then switch to your target application and paste the barcode (e.g. in Microsoft
®
 Word) by pressing 

Ctrl-V (or by selecting Edit ► Insert from the menu). 

When copying the barcode to the clipboard, the barcode data is represented in a vector based 
format (EMF). 

► Advantage: You may resize the imported image within your target application without heavy 
losses in readability. 

► Disadvantage: Due to internal preprocessing the resulting barcodes may differ from the 
preview in Barcode Studio. The bars in the symbol may be enlarged and therefore the font 
of the human readable text may not fit exactly. 

5.4 Export to File 

To export a barcode to an image file, select File ► Export Image… from the menu or press the 
keyboard shortcut Ctrl+E. Then choose a filename, select the image file type (e.g. “Bitmap (*.bmp)”) 
and press the Save button. 

The saved image can be imported in your target application (e.g. Microsoft
®
 Word). To import the 

image in Word you would select Insert ► Image ► From File… from the menu. 

The barcode can be exported to various image file formats. For a list of available formats, please 
refer to Appendix C. 

 

► The exported barcode symbol will match the preview in Barcode Studio exactly. 

► When using a bitmap based file format (see Appendix C) resizing of the imported image is 
not recommended! 

5.5 Export a Series of Barcode Images 

For an automated export of a series of barcode images you can use the Create Sequence function. 
This function is described in chapter 8. 
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6 Barcode Studio 

6.1 Main Window 

 
Figure 2: User Interface 

The main window is split into the following areas: 

� Menu (see section 6.2). 

� Main Toolbar (see section 6.3). 

� Symbology / Data (see section 6.4). 

� Design Window (see section 6.5). 

� Quality Watch (see section 6.7). 

� Barcode Dimensions (see section 6.6). 


 Button Toolbar (see section 6.8). 

� Status Bar. 

� Hint Area. 

 

� 


 

� 

� 

� 

� 

� 

� 

� 
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6.2 Menu 

The menu gives you access to the following functions: 

6.2.1 File 

New Create a new document (with initial barcode settings). 

Shortcut: Ctrl+N 

Open… Open an existing barcode settings file (*.BCS). 

Shortcut: Ctrl+O 

Save Save the current barcode settings (symbology, dimensions, module width, …) as file. Only 
the settings (no barcode data) will be saved. Barcode settings files use the file extension 
.BCS which will be added to the filename automatically. 

Shortcut: Ctrl+S 

Save as… Save the current barcode settings as file. The file name can be chosen via dialog. 

Export Image Export the current barcode as image file.  
The size (resolution, pixels…) can be set in the “Dimensions” toolbar �  (see Figure 2). For 
a list of available image file formats, please refer to Appendix C. 

Shortcut: Ctrl+E 

Print… Print the current barcode.  
You can print out the barcode to a laser-, inkjet-, label- or any other printer with appropriate 
quality. The value for tolerance depends on the current printer settings. The values for 
resolution depend on the default settings (default printer).  
Note: For inkjet printers you can specify a bar width reduction (see section 7.3.11). 

Shortcut: Ctrl+P 

Print Preview Open the print preview. 

Print Setup… Choose the printer, the paper size and the orientation. 

Exit Exit Barcode Studio. If you have unsaved changes, Barcode Studio will prompt you to save 
before exiting. 

6.2.2 Edit 

Undo Not available. 

Copy to Clipboard Copy the barcode to the clipboard. 

Shortcut: Ctrl+C 

6.2.3 View 

Symbology / Data Show/hide the Symbology / Data toolbar. 

Button Toolbar Show/hide the Button toolbar. 

Barcode Dimensions Show/hide the Barcode Dimensions toolbar. 

Quality Watch Show/hide the Quality Watch. 

Hints Show/hide the Hints area. 

SAP Parameters Show/hide the SAP Parameters toolbar. 

Toolbar Show/hide the main toolbar. 

Status Bar Show/hide the status bar. 

6.2.4 Barcode 

Data… Open the Edit Data dialog. 

Fonts and Colors… Open the Fonts and Colors dialog. 

Settings… Open the general barcode settings dialog. 

Shortcut: Ctrl+1 

2D/Composite 
Settings… 

Open the advanced barcode settings dialog (available for 2D and for composite barcodes). 

Shortcut: Ctrl+2 
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6.2.5 Sequence 

Create Sequence Export a sequence of barcodes as images.  
For more information, please refer to chapter 8. 

Shortcut: Ctrl+Q 

6.2.6 Help 

Documentation… Open this document from within Barcode Studio. 

License… License dialog to license Barcode Studio. 

About Barcode Studio.. Display information about Barcode Studio and the program version. 

6.3 Main Toolbar 

 
Figure 3: Main Toolbar 

The main toolbar offers the following functions: 

 New Create a new document (with initial barcode settings). Shortcut: Ctrl+N 

 Open Open an existing barcode settings file (*.BCS). Shortcut: Ctrl+O 

 Save Save the current barcode settings to your hard disk. Shortcut: Ctrl+S 

 Export Image File Export the current barcode as image file. Shortcut: Ctrl+E 

 Cut Not available. 

 Copy Copy the barcode to the clipboard. Shortcut: Ctrl+C 

 Print Print the current barcode. 

 About Display information about Barcode Studio and the program version. 

 SAP Control Parameters Open the  SAP Parameters toolbar.  
For more information, please refer to chapter 9. 

6.4 Symbology / Data 

 
Figure 4: Symbology / Data 

6.4.1 Barcode Type 

Select the barcode type (symbology) in �. 

► For Codablock, PDF417, MaxiCode, Data Matrix, QR-Code, all RSS stacked symbologies 
and for all composite symbologies (RSS, EAN.UCC) you need a 2D license. All other sym-
bologies can be created with a 1D license. 

If you want to learn more about the selected symbology, click the “?”-button �. A HTML-page with 
detailed information on the barcode will open. 

6.4.2 Barcode Data 

Enter the data to be encoded in �. 

Alternatively the barcode data can be edited in the data input dialog (see section 7.1). You can 
open this dialog by double clicking the barcode in the design window. 

� � � 
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6.5 Design Window 

 
Figure 5: Design Window 

The design window shows the barcode in its actual appearance (as it is printed). 

To change the size of the barcode click and drag the borders of the blue bounding rectangle � or 
enter the required dimensions in the “Barcode Dimensions” toolbox (see section 6.6). The “Barcode 
Dimensions” toolbox shows the width, the height and the module width of the barcode as numeric 
values.  
The quality of the barcode can be rated depending on the output resolution and the module width. 
This quality is shown in the quality watch toolbar (see section 6.7). 

The hint area � can be enabled/disabled via the menu entry View ► Hints. 

 

 

When clicking on the barcode with the right mouse 
button a context menu appears. 

You can use this menu to access the barcode 
properties and to copy the barcode to the clipboard.  

 

� 

� 
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6.6 Barcode Dimensions 

 
Figure 6: Barcode Dimensions 

6.6.1 Unit 

This value specifies the measurement units for displaying and/or entering the dimensions of the 
barcode. Possible values are:  

� Millimeter 

� Inch 

� Mils (=1/1000 inch)  

� Pixels. 

6.6.2 DPI 

Selects the resolution of the output image (in dots per inch). Select a value from the combo box or 
enter your own value. 

If you want to export the barcode to an image file, you should increase the resolution of the image 
to ensure proper barcode quality. The entered value also influences the resolution used in the func-
tion “Copy to clipboard”. 

To estimate the print-quality of a barcode for a specific printer model (and therefore printer reso-
lution) choose “Printer Resolution” as DPI and “Pixels” as measurement unit. Use the Quality Watch 
(see section 6.7) to verify the quality of the barcode for the actual printer without printing it. 

► If “Screen Resolution” or “Printer Resolution” is selected the actual dpi value is shown in the 
status bar (e.g. “96 dpi” for screen resolution or “600 x 600 dpi” for printer resolution). 

► Note: “Export Image” is not available, if “Printer Resolution” is selected! 

6.6.3 Width, Height 

Sets the width and height of the barcode. 

6.6.4 Module Width 

The module width can be adjusted by entering a value in the edit box or by changing the position of 
the slider below. 

The barcode is divided into individual "modules". A module is the width of the smallest bar (or 
space) segment. The module width is the fundamental measuring unit for barcodes, i.e. all lines 
and spaces are based on this adjustment. Normally, the module width is calculated automatically 
based on the width of the blue bounding rectangle and on the amount of data to be encoded. But 
it can also be set to a fixed value.  
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Depending upon the printer or image resolution, the lower limit for the module width may be 
exceeded – leading to unreadable barcodes (e.g.: if the module width is smaller than 1 pixel). Make 
sure that the barcode bounding rectangle is as wide as necessary if you are using fixed module 
width. 

MaxiCode: this barcode type has a predefined constant module width to achieve the standard-
ized symbol dimension. However, you can change the module width on demand. 

6.6.5 Optimize Resolution 

For lower resolutions Barcode Studio provides the possibility to enhance the barcode quality and 
therefore the scanning results. If the “Optimize Resolution” checkbox is enabled, the module width 
of the barcode will be set to an integer pixel size (using the nearest lower value). Hereby the 
printing tolerance and pixel aberration is reduced to a minimum or eliminated completely.  
In other words: The barcode will be printed using whole multiples of the pixel size only. This avoids 
aliasing effects and guarantees optimum scanning quality. 

► If optimize resolution is enabled, the module width will be adjusted for optimum output quali-
ty. The width of the rectangle (barcode width/height) will not be changed. 

► In the design window this difference can only be seen, if the DPI is set to “Screen Reso-
lution”. For higher output resolutions the screen preview is not detailed enough for showing 
the automatic bar width adjustments. 

6.7 Quality Watch 

 
Figure 7: Quality Watch 

6.7.1 Tolerance 

To achieve optimum readability by scanning devices you should try to minimize the printing tole-
rance. The bar/space width aberration depends on the output resolution and the internal print ratio 
of the barcode. Not only by choosing a high output resolution, but also by choosing an appropriate 
module width the bar/space tolerance can be minimized. Select “Pixel” as measurement unit and 
enter an integer value (1, 2, 3, … 25, …) for the module width. This should give you the best pos-
sible output quality. 

The tolerance field will report one of the following values: 

Tolerance Aberration Description 

Perfect 0% Best possible output quality.  

Fair 1-15% Should be readable with most barcode scanners. 

Poor 16-25% May be readable. 

Bad! 26-50% Not readable in most cases. 

Data Loss! 51-100% Total or party loss of information. Unreadable barcode. 

Table 2: Barcode Qualities 

6.7.2 Quality 

Displays the quality – the higher the tolerance the lower the quality. 
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6.8 Button Toolbar 

 
Figure 8: Button Toolbar 

6.8.1 Settings 

Opens the barcode settings dialog. 

You can also use the keyboard shortcut Ctrl+1 to open the settings dialog. 

6.8.2 2D Settings 

Opens the advanced settings dialog for 2D barcodes like Data Matrix, MaxiCode, QR-Code, PDF-
417 and Codablock F.  

Please note, that this option is only available if you chose one of the 2D symbologies. 

You can also use the keyboard shortcut Ctrl+2 to open the 2D settings dialog. 

6.8.3 Composite Settings (not shown in picture) 

If the chosen barcode symbology is available in a composite variant, a button named “Composite 
Settings” appears instead of the button “2D Settings”. 

6.8.4 Fonts and Colors 

Opens a dialog for adjusting barcode fonts and colors. 

6.8.5 Copy to Clipboard 

Pressing this button will copy the actual barcode into the clipboard as image. The module width is 
automatically optimized for best readability (similar to Optimize Resolution, see section 6.6.5). 
Therefore little changes in the width of the inserted barcode may occur. 

6.8.6 Create Sequence 

Opens the “Create Sequence” dialog (see chapter 8). 
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7 Barcode Settings 

7.1 Data 

The barcode data can be entered in the “Symbology/Data” toolbar (see �) or in the “Barcode Data” 
dialog. 

 
Figure 9: Barcode Data (Toolbar) 

To open the “Barcode Data” dialog double-click on the barcode in the design window or select Bar-
code ► Data… from the menu. Alternatively you can right-click on the barcode and select Data… 
from the pop-up menu. The following dialog will appear: 

 
Figure 10: Barcode Data (Dialog) 

This dialog allows you to enter the barcode data in a multi-line edit control (�) or to import the data 
from a text file (�). 

► Not all barcode types are able to represent all possible data-characters. Some barcode 
symbologies can represent digits only. Others can represent digits plus a limited amount of 
special characters like “/” or “*”. And a few barcode types can encode all ASCII characters. 

7.1.1 Check Digit Override 

Some barcodes with a predefined number of utilizable data characters (like all EAN, UPC, Postnet 
and RSS-14 codes) include a check digit on a fixed position in the barcode data. 

Example: 

 
 

The EAN13 code permits 12 utilizable digits plus 1 check digit at the 
last position (�). 

If you enter 12 digits as barcode data this last digit (the check digit) 
will be calculated and inserted automatically. However, you can also 
enter all 13 digits and therefore override the calculated check digit. 

 

► Note: If the check digit is supplied within the barcode data, the internal check digit calcula-
tion will be switched off. 

► Barcode Studio does not check the correctness of the check digit supplied by your 
application. 

� 

� 

� 

� 
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Under normal circumstances you should not use this feature – we recommend calculation of the 
check digit(s) by Barcode Studio. 

7.2 Font and Colors 

To change the font and the colors of the barcode choose Barcode ► Font and Colors… from the 
menu. Alternatively you can right-click on the barcode in the design window and select Font and 
Colors… from the pop-up menu. The following dialog will appear: 

 
Figure 11: Font and Colors 

This dialog allows you to change the font type and size used for the “human readable text”: 

7.2.1 Change Font 

Opens a dialog where you can enter the font name, style (regular, bold, italic) and size. Changing 
the font color within this dialog has no effect on the barcode design. Use setting � instead. 

7.2.2 Fore Color 

The foreground color of the barcode (color of the bars). 

7.2.3 Back Color 

The background color of the barcode (color of the spaces). 

7.2.4 Text Color 

The color of the “human readable text”. 

7.2.5 Back style 

Mode for drawing the background of the barcode. The background can be set transparent (= 
default, background shines through) or opaque (background is overwritten with the background 
color). This setting is relevant if you use copy and paste (clipboard). 

� 
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7.3 Barcode Settings 

 
Figure 12: Barcode Settings 

7.3.1 Check Digit 

The calculation method for the check digit. In order to guarantee that the barcode data is read 
properly a check digit can be added to the end of the utilizable data. A comparison of the barcode 
content with the check digit informs the scanning device (scanner) about incorrect scans and forces 
the device to repeat (or reject) the scan. The check digit calculation method is standardized for 
certain common barcodes. Using check digits is mostly optional – but often recommended for 
particular symbologies and standards. 

With the default-adjustment the check digit is calculated according to the specification of the 
selected barcode. Modifications within this area are admissible for special applications or for bar-
codes with selectable check digit methods only. 

For additional information on check digit calculation, please refer to the “Barcode Reference” 
available from www.tec-it.com. 

7.3.2 Show Human Readable Text 

Selects, whether the content of the barcode is printed as “human readable text“ or not. (Default: 
yes.) 

7.3.3 Text Distance 

The distance between the “human readable text” and the barcode (in 1/1000 mm). 
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7.3.4 Alignment 

Alignment of the human readable text (default, left, right, centered). 

7.3.5 Print Text Above 

Position of the “human readable text”: below or above the barcode symbol (Default = below). 

For some barcode types like UPC and EAN the adjustment “Above symbol” is not permitted. 

7.3.6 Print Ratio 

The print ratio describes the relationship between the widths of the single bars and spaces of a 
barcode (do not mix this up with the width/height ratio!). The input format depends on the selected 
barcode type and shows how many different bar and space widths are used. The resulting width of 
a bar (or space) is calculated using the indicated print ratio and the (calculated or specified) module 
width. 

Example: If a barcode element has 4 different bar widths and 4 different space widths, then the print 
ratio looks like this (Code 128): 1:2:3:4:1:2:3:4.  
In the first part ("1:2:3:4") the width ratio of the bars is set, in the second section the relation of the 
spaces is set (in this case, they are the same). The smallest bar is "1" wide, the next larger is "2" 
(thus twice as wide as the smaller bar) and so on. 

► Modifications within this area make sense for special applications only! For the Code 2OF5 
interleaved, e.g., the print ratio can range from 1:2 to 1:3. 

► Use this option with care! Barcodes may become unreadable when setting a wrong print 
ratio. 

For additional information on print rations, please refer to the “Barcode Reference” available from 
www.tec-it.com. 

7.3.7 Format/Subset 

The format string is used for formatting the utilizable data of the barcode according to defined rules. 
It operates with substitute symbols to indicate how the data shall be structured.  
With the format string it is possible to insert constant characters to the barcode data. Control 
characters make it possible to change the Subsets for Code 128, EAN 128 and UCC 128 (or to 
define the desired start/stop character of CODABAR). 

For more information on format strings, please refer to the “Barcode Reference” available from 
www.tec-it.com. 

7.3.8 Guard Width [1/1000 mm] 

The guard bar is a horizontal line, which limits the barcode on the upper and lower side. If the value 
is not set to zero the guard bar is printed. Values larger than zero indicate the width of the guard bar 
in 1/1000 mm. For some types (like UPC and EAN) the value must be zero. 

7.3.9 Notch Height [1/1000 mm] 

The height at which the synchronization bars extend the regular barcode height (e.g. the double 
lines within EAN on the left, center and on the right side). 

7.3.10 Quiet Zone [Modules] 

The quiet zone can be set for some barcodes. The entered value will be added to the left and to the 
right of the symbol. 

For the Data Matrix (2D) symbology the quiet zone will be added to all four sides of the code. 
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7.3.11 Bar Width Reduction [% of Mod.W.] 

When printing on inkjet printers, the ink that is absorbed by the paper tends to diffuse. Setting the 
bar width reduction allows you to work against this spreading of ink. 

The bar width reduction can be specified in percent of the module width. Thus when set to 20 all 
bars will be narrowed by 20 percent of the module width. 

► Be careful: Setting the bar width reduction to more than 50 percent might leave the barcode 
unreadable! When using this feature we recommend you to do some test-scans to make 
sure that the barcode can be scanned correctly. 

7.3.12 Translate Escape Sequences 

Specifies, whether escape sequences (like ”\n”) are to be translated or not (default: no). For a list of 
recognized escape sequences, please refer to the additional document “Barcode Reference” 
available from www.tec-it.com. 

The use of escape sequences is useful if you need to encode control characters like carriage return 
or FNC1 into the barcode. 
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7.4 2D Settings – PDF417 

To open the 2D Settings dialog for the PDF417 barcode, select barcode type “PDF417” and then 
click 2D Settings in the button toolbar. Alternatively you can right-click on the barcode in the design 
window and select 2D Settings… from the pop-up menu or press the keyboard shortcut Ctrl+2. The 
following dialog will appear: 

 
Figure 13: PDF417 Properties 

The PDF417-page is used to modify the standard behavior of the two-dimensional PDF417 bar-
code. PDF417 divides data contents into rows and columns – it is a stacked symbology with error 
correction capabilities. This page is not relevant for other symbologies. 

► Be careful when modifying these adjustments. Always make a test scan in case of doubt! 

7.4.1 Rows [3..90] 

The number of rows used for encoding. The value must be between 3 and 90. Default: the number 
of lines is calculated automatically depending on the number of input characters. 

7.4.2 Columns [1..30] 

The number of columns used for encoding. The value must be between 1 and 30. Start-, stop- and 
line-indicator columns are not taken into account. Default: the number of columns is calculated 
automatically depending on the number of input characters. 

7.4.3 Row Height [1/1000 mm] 

The height of an individual row in 1/1000 mm. If specified, the barcode height will remain locked at 
the specified value. (Modifying the barcode dimensions will only affect the barcode width.). Default: 
the row height is calculated automatically depending on the number of input characters. 

7.4.4 Error Correction Level 

The error correction level. The value can be between 0 (only error recognition) and 8 (highest). 
Default: the level is calculated automatically between 2 and 5 - according to the number of input 
characters. 
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7.4.5 Use Macro PDF417 

Inserts a Macro PDF control block into the bar code. 

PDF417 allows the user data to be spread across several symbols. This might be done if the data is 
too large to fit into a single symbol or for reasons of appearance and geometry. 

The so called “Macro PDF Control Block” carries information that relates its contents to the overall 
data. The below described properties are mandatory for the Macro PDF functionality. 

7.4.6 Segment Index 

Index of the actual data segment in the symbol chain. Start with 1 and increase for each additional 
symbol in the data chain. Value range = 1…99999.  
Note: when reading the encoded data with a scanner, the index will be zero-based. 

7.4.7 Last Symbol 

Identifies the last symbol in your data chain. If set to true, the “Last Segment Indicator” is put at the 
end of the Macro PDF control block. 

7.4.8 File ID 

The file id identifies all symbols, which belong to the same data chain. For reassembling, all data 
blocks having the same File ID are concatenated in the order of increasing segment index. 

7.4.9 Advanced (optional fields) 

These fields are optional and may be encoded into the Macro PDF417 control block on demand. 

 
Figure 14: Macro PDF417 Optional Settings 

File name (alphanumeric) File name (variable length field). 

Segment count (numeric) Total number of data segments (range 1…99999). 

Time stamp (numeric) Time stamp (elapsed time in seconds since January 1, 1970 00:00 GMT). 

Sender (alphanumeric) Sender (variable length field). 

Addressee (alphanumeric) Addressee (variable length field). 

File size (numeric) Total number of Bytes encoded (variable length field). 

Checksum (numeric) 16-Bit CRC checksum (using CCITT-16 polynomial x16 + x12 + x5 + 1 over the 
entire data). 
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7.5 2D Settings – Micro PDF417 

This page allows you to modify the standard behavior of the two-dimensional Micro PDF417 bar-
code. 

 
Figure 15: Micro PDF417 Properties 

7.5.1 Mode 

Specifies how data is encoded as Micro PDF417. In most cases the “Default” or the “Binary” mode 
is the best choice. Often the scanner hardware does not support all modes listed here – check with 
your scanner first. 

 

Mode (Enumeration) Description 

Normal (Default) Input data is analyzed. Text, numeric or binary compaction mode will be used according-
ly (to produce the smallest symbol). 

Binary Compaction Use binary mode for encoding (without data analysis). 

UCC/EAN-128 Emulation UCC/EAN-128 Emulation mode. Transmit ]C1 or ]L3. 

Use compaction for Application Identifier (AI) "01" + 14 digits. 

Code128 Emulation Code-128 Emulation mode. Transmit ]C2 or ]L4. 

Code128 FNC2 Emulation Code-128 with FNC2 on first position will be emulated. 

Linked UCC/EAN-128 Linked UCC/EAN-128 emulation. Transmit ]C1 or ]L3. 

Indicates that the Micro PDF symbol is linked with a linear symbol (which may be 
required for a successful scan). 

Using this mode, the following AI’s in the given order can be encoded with better 
compaction: 

� date (AI 11, 13, 15 or 17) + lot number (AI 10) + other AI’s (optional). 

� date (AI 11, 13, 15 or 17) + serial number (AI 21) + other AI’s (optional). 

� date (AI 11, 13, 15 or 17) + other AI’s (optional). 

Note: This mode is not used with UCC EAN Composite Symbology, which uses linked 
symbols, too. 

05 Macro The preamble [ ( > RS 0 5 GS precedes the encoded data. 

06 Macro The preamble [ ( > RS 0 6 GS precedes the encoded data. 

CC-A Data Mode For special applications only: use Base-928 compaction and process input data as byte 
array. 

CC-B Data Mode For special applications only: use binary compaction (Base-900), prefix symbol data with 
reserved symbology code word. 
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7.5.2 Version 

Specifies the “size” of the symbol in terms of codeword-columns and Micro PDF417 rows. 

7.5.3 Row Height [1/1000 mm] 

Sets the height of an individual row in 1/1000 mm. If specified, the barcode height will remain locked 
at the specified value. (Modifying the barcode dimensions will only affect the barcode width).  
Default: the row height is calculated automatically depending on the number of input characters. 

7.5.4 Macro PDF417 

Macro PDF is supported in PDF417 as well as in Micro PDF (for details, please see also PDF-417 
properties). 

Macro PDF417 is used for connecting multiple Micro PDF417 symbols into one data chain. You can 
specify the segment index of the actual symbol, the File-ID that specifies all symbols of one chain 
and whether the current symbol is the last in the chain. 

For more settings please click the “Advanced” button: The fields “file name”, “segment count”, “time 
stamp”, “sender”, “addressee”, “file size” and “checksum” are optional and may be encoded into the 
Macro PDF417 control block on demand. 
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7.6 2D Settings – MaxiCode 

MaxiCode represents data by drawing hexagonal items, which are arranged around a circular 
center (a so called "Bull's Eye"). The internal data structure is regulated by different "modes". The 
mode "Structured Carrier Message" was defined by the parcel transport service UPS

®
. Data can be 

encoded with two different error correction levels (SEC = Standard Error Correction and EEC = 
Enhanced E.C.). 

MaxiCode's design is very flexible. With “Structured Append” you can divide larger quantities of data 
into several MaxiCode symbols – they are joined by the scanner. The maximum data capacity of 
one symbol is 93 characters. The actual quantity of the utilizable data depends on the selected 
mode, how often special characters are used, whether numeric sequences (which can be 
compressed) are used and which level of error correction is adjusted. 

 
Figure 16: MaxiCode Properties 

7.6.1 Mode 

Mode (Enumeration) Description 

Mode 4 (Default value) For numeric and alphanumeric character sequences (incl. standard error correction). 

Mode 2 SCM numeric – Structured Carrier Message, up to 9 digits (postal code can use digits 
only). 

Mode 3 SCM alphanumeric – Structured Carrier Message, up to 6 characters (postal code can 
also use alphanumeric characters). 

Mode 5 Full EEC – like mode 4 but with maximum error correction (safer, but fewer utilizable 
data possible). 

7.6.2 Undercut [0..100] 

The undercut influences the diameter of the hexagonal barcode elements. In new applications it is 
recommended (according to the AIM standard) to use an undercut setting of 75% (default). 

7.6.3 Preamble Options 

Used particularly in “Open System Standards”. Under “Preamble Date” the last two digits of a year 
can be entered. They are inserted automatically into the data stream in a predefined place. 
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7.6.4 Structured Append 

If you want to “connect” several MaxiCode symbols in order to encode larger quantities of data, then 
you can use “Structured Append" (this feature is called Macro-mode in other symbologies). A 
symbol identification number which is entered in the “index” field can be assigned to each Maxi-
Code symbol. Its value can range between 1 and 8. This index indicates the order, in which the data 
is joined after the reading/scanning process. The total number of arranged MaxiCode symbols must 
be entered in “Number of all symbols”. 

7.6.5 Structured Carrier Message (SCM) 

MaxiCode was originally developed by UPS
®
 (United Parcel Service). In the operating mode 

"Structured Carrier Message" (mode 2 and 3) there are defined data fields for UPS
®
-purposes. 

These can be entered in the fields ”Service Class”, ”Country Code” and ”Postal Code”. In “Mode 3” 
you can use digits as well as alphanumeric characters for the “Postal Code”. 

By using escape sequences it is possible to insert the values for date, preamble, service class, 
country and postal code directly into the barcode data (text property). To learn more about this 
possibility, please refer to the additional document “Barcode Reference” available from www.tec-
it.com. 
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7.7 2D Settings – Data Matrix 

Advanced properties for Data Matrix.  

► Please note, that Barcode Studio always uses ECC 200 error correction. 

 

 
Figure 17: DataMatrix (ECC200) Properties 

7.7.1 Code Format 

Code Format  (Enum.) Description 

Default Standard format. 

UCC/EAN Special format defined by UCC and EAN. Used for encoding Application Identifiers. 
(FNC1 at 1st position). 

Industry Supports peculiar industry formats (FNC1 at 2nd position). 

Macro 05 [)>Rs05Gs is encoded at the beginning of the code. 

Macro 06 [)>Rs06Gs is encoded at the beginning of the code. 

7.7.2 Symbol Size 

The size of the symbols as number of rows and number of columns. Possible sizes are "10 x 10" to 
"144 x 144" modules for a square symbol and "8 x 18" to "16 x 48" for a rectangular symbol. When 
set to default the minimal possible square size is used (depending on input data). 

7.7.3 Show as Rectangle 

Determines if the Data Matrix symbol should be displayed as a rectangle (checked) or a square 
(unchecked - default). 

7.7.4 Structured Append 

If you want to “connect” several Data Matrix symbols in order to encode larger quantities of data, 
then you can use “Structured Append". A symbol identification number - which is entered in the 
“index” field - can be assigned to each Data Matrix symbol. Its value can range from 1 to 16. This 
index indicates the order, in which the data is joined after the reading/scanning process. The total 
number of arranged Data Matrix symbols must be entered in “Number of all symbols”. The “File ID” 
has to be the same for all symbols within such a chain. 
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7.8 2D Settings – QR-Code 

The QR Code symbology is a 2-dimensional matrix symbology (similar to Data Matrix). Remarkable 
is the large data capacity (up to 3000 ASCII characters or 7000 digits). QR Code means Quick 
Readable code – it was originally designed to read and decode symbols with high amounts of data 
within a minimum of time. 

 
Figure 18: QR-Code Properties 

7.8.1 Code Format 

Code Format (Enum.) Description 

Default Standard format. 

UCC/EAN Special format defined by UCC and EAN. Used for encoding Application Identifiers. 
(FNC1 at 1st position). 

Industry For special industry formats (FNC1 is inserted at second position). If you choose this 
value, you also have to fill in the field Application Indicator (2 digits or 1 letter). It 
determines to which industry format the input data (should) correspond(s). 

7.8.2 Symbol Version 

Defines the version (= size) of the QR Code symbol by setting version number, number of rows and 
number of columns. Possible values extend from „(1) 21 x 21" up to „(40) 177 x 177" modules for a 
square symbol. If the property is set to default, the size is computed automatically based on the 
data to be encoded. 

7.8.3 Error Correction Level 

Defines the error correction level. You can choose from following possible values: 

Error Correction Level 
(Enum.) 

Description 

(L)ow Lowest level. Data recovery capacity is up to approximately 7%. 

(M)edium (default) Up to 15%. 

(Q)uartil Up to 25%. 

(H)igh Highest level. Up to 30%. 
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7.8.4 Mask Pattern 

Specifies the mask pattern that is applied to the symbol to improve readability. 

Mask Pattern (Enum.) Description 

Default The mask pattern is calculated automatically. 

0..7 With the values 0 to 7 you choose the appropriate mask pattern. It would make sense to 
specify this setting directly, especially, if you have to generate many symbols within 
minimal computation time. The algorithm to calculate the optimal mask is highly complex 
(and therefore very resource consuming). 

7.8.5 Compact Kanji Characters 

QR-Code supports compaction of Kanji characters (if present in the MultiByte character set Shift JIS 
X 0208). The Kanji characters are compacted into a 12-Bit codeword (instead of a 2 Byte / 16 Bit 
codeword) – so you need less space in the symbol. It is recommended to enable this compaction 
only if you have Kanji characters in your input data (not recommended for binary data). 

7.8.6 Structured Append 

If you want to “connect” several QR Code symbols in order to encode larger quantities of data, then 
you can use “Structured Append". A symbol identification number which is entered in the “index” 
field can be assigned to each QR Code symbol. Its value can range from 1 to 16. This index indi-
cates the order, in which the data is joined after the reading/scanning process. The total number of 
arranged symbols must be entered in “Number of all symbols”.  

Chained QR Code symbols are identified by the parity byte. The parity byte must be identical in all 
symbols. The value can be calculated using the method „QR_StructAppParity“ which is part of 
TBarCode.  
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7.9 2D Settings – Codablock F 

The Codablock F property page is used to adjust symbology specific parameters. Similar to PDF-
417 the data content is divided into rows and columns. Codablock F is a stacked symbology with 
additional internal checksums for error recognition.  

Codablock F is based upon the Code 128 symbology - one data row consists of a single Code 128 
barcode extended with row identifiers and column check sum. This page is not relevant for other 
symbologies. 

► Caution when modifying these adjustments. Always make a test scan in case of doubt!  

 

 
Figure 19: Codablock F Properties 

7.9.1 Rows [2..44] 

The number of graphical rows used for encoding. The value must be between 2 and 44. Default: the 
number of lines is calculated automatically depending on the number of input characters. 

7.9.2 Columns [4..62] 

The number of graphical columns (data words), which are to be printed. The value must be between 
4 and 62. Start-, stop- and line-indicator columns are not taken into account. Default: the number of 
columns is calculated automatically depending on the number of input characters. 

7.9.3 Row Height [1/1000 mm] 

The height of an individual row in 1/1000 mm. If specified, the barcode height will remain locked at 
the specified value. (Modifying the barcode dimensions will only affect the barcode width.) Default: 
the row height is calculated automatically depending on the number of input characters. 

7.9.4 Separator Height [1/1000 mm] 

The width of the row separator line in 1/1000 mm. Default: the line width is equal to the module 
width (calculated automatically depending on the symbol size).  

7.9.5 Code Format 

Code Format  (Enum.) Description 

Standard Standard format 

UCC/EAN special format defined by UCC and EAN to be used in UCC/EAN applications. 
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7.10 2D/Composite Symbology Settings 

Composite symbologies are available for the following barcodes: 

� EAN8 

� EAN13 

� RSS14 

� RSS14 Stacked 

� RSS14 Stacked Omnidirectional 

� RSS14 Truncated 

� RSS Expanded 

� RSS Expanded Stacked 

� RSS Limited 

� UCC/EAN128 

� UPC-A 

� UPC-E 

 

By default Composite Component Symbology creation is disabled.  

To enable composite symbologies please select Barcode ► Composite Settings… from the menu 
or the button toolbar. The following dialog will appear. 

 
Figure 20: Composite Symbology Settings 

7.10.1 2D Composite Component Symbology 

None Composite Symbologies are disabled. 

Auto Automatically choose CC-A, CC-B or CC-C Symbology depending on the length of the input data. 

CC-A CC-A is a variant of the MicroPDF417 Symbol with a unique combination of row address patterns 
(RAP). It is the smallest variant of the 2-dimensional composite component. Up to 56 digits of 
alphanumeric data can be coded with 3 to 12 rows and 4 columns. 

CC-B CC-B is a subset of the MicroPDF417 Symbol, which is identified by the code word 920. Encoding 
systems choose CC-B automatically when CC-A has not enough capacity (Auto-mode). CC-B 
encodes up to 338 digits of alphanumeric data in 3 to 12 rows and 2 to 4 columns. 

CC-C The CC-C structure is a PDF417 Symbol, which is identified by the internal code word 920 (920 is the 
first code word after the symbol length indicator). The CC-C structure can be used as a 2 dimensional 
composite component of a UCC/EAN-128 Composite Symbols. It has the largest data capacity of 
EAN.UCC Composite Symbols because of its possibility to code of up to 2361 numbers. It can code 
numbers with up to 2361 digits of alphanumeric data, which have 3 to 30 rows and up to 30 Data-
Error-checking-Code-Columns. 
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7.10.2 Specifying Barcode Data for Composite Symbologies 

If either “Auto”, “CC-A”, “CC-B” or “CC-C” is selected, Composite Symbology will be enabled. 

To separate the composite data from the linear barcode data please use the vertical bar 
character "|". 

Example: 
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7.11 2D/RSS Expanded Stacked Properties 

7.11.1 2D Composite Component Symbology 

Same as described in section 7.10.1. 

 
Figure 21: RSS Expanded Stacked Properties 

7.11.2 Segments per Row 

Number of segments per row in the stacked linear component of the barcode. If the “Default” 
checkbox is checked 4 segments will be used. 
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8 Sequences 

8.1 General 

With Barcode Studio you can automatically generate of a series of barcode images for a given list 
of barcode data strings. 

Select Sequence ► Create Sequence.. from the menu to open the following dialog: 

8.2 Barcode Sequence 

 
Figure 22: Barcode Sequence 

The sequence list � shows a preview of all barcode data strings. For each sequence item a 
barcode image file will be generated. The file names are based upon a prefix, the item value 
(=barcode data) and the file extension. 

For populating this list you can 

� Create a sequence (�) or 

� Import a sequence (�) from a text file. 

Button � allows you to delete all items in the sequence list. 

8.2.1 Create Sequence 

8.2.1.1 Start Value 

Defines the start value for the sequence. Must be smaller than the end value. 

� 

� 

� 
� 
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8.2.1.2 End Value 

Defines the end value for the sequence. Must be smaller than the start value. 

8.2.1.3 Increment 

This value specifies the incremental step between consecutive list items. 

► This number has to be chosen carefully. After incrementing each item in the sequence the 
result must be equal to the given end value. Otherwise a sequence will not be created. 

8.2.1.4 Format 

Defines the format, which will be applied to all items of the sequence. The number of specified 
characters defines the length for each item of the sequence. This format can contain the following 
characters: 

Character Description 

# Barcode Studio inserts blanks at the beginning of the barcode as placeholders if the number of characters 
given in Format string exceeds the number of characters in the item of the sequence. 

$ Zeros are inserted at the beginning of the barcode instead of blanks. 

* Stars are inserted at the beginning of the barcode as placeholders. 

Examples: 

Format 
String 

Sample Output Description 

$$ 01, 02, 03, …, 10, 11 Leading zeros 

##   1,   2,   3, …, 10, 11 Leading spaces 

**  *1, *2,  *3, …, 10, 11 Leading asterisks 

 

► If you chose “$$$” and create a sequence containing numeric values higher than 999, the 
barcode data will be truncated. In this case change the format string. 

8.2.1.5 Create 

After specifying the start value, the End value, the “increment” and the format string you are ready 
to create the sequence. Click Create to start. 

► You can interrupt the sequence generation at any time by pressing Esc. 

8.2.2 Import Sequence 

In order to import the sequence data from a file click the Import button. 

In the appearing dialog you can specify the file to be imported. Allowed are *.txt files and *.csv files. 
Each line in the import file will be one value in the item list. 

► You can interrupt the import at any time by pressing Esc. 

► The sequence item list will be cleared automatically before the import starts. 
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8.2.3 Export Images 

The Export Images button opens a separate dialog in which you can choose the desired image file 
format, the prefix for the file name and the path where to store the exported image files. For each 
item in the sequence list, one image file will be generated. 

 
Figure 23: Export Images from Sequence 

If the checkbox “Use URL style format” is checked, all characters which are not allowed in file-
names will be URL encoded. 

If a value in the sequence item list cannot be encoded with the actual selected barcode type (e.g. 
only digits allowed for 2of5 IL) the export function will be terminated. Another interruption can occur 
if the actual value can not be used as file name and the checkbox “Use URL style format” was not 
checked. 

Keep in mind that exporting many sequence items can take a lot of time and hard drive space! 

If you import your values from an external file and the values to be encoded are varying in amount 
of digits or letters you will get different graphical densities in your barcodes. Make sure that your 
barcodes are readable: make test scans with the barcode having the largest amount of data. 
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9 SAP R/3 Print Control Parameters 

9.1 General 

TEC-IT offers the product TBarCode/SAPwin. This product enables barcode printing on all 
Windows printers from within SAP. It can be used with SAPlpd (a part of SAPGUI), SAPsprint and 
SAPWIN.DLL. In order to print barcodes in SAP R/3 (R/3 Enterprise, MySAP.com, …) the Print 
Controls must be configured correctly. Barcode Studio offers functionality which simplifies this 
process. 

9.2 SAP R/3 Print Control Parameters Window 

Open the SAP R/3 Print Control Parameters window by clicking the SAP R/3 symbol � in the main 
toolbar: 

 

The following window opens: 

 

This window displays the SAP R/3 Print Control parameters for the selected barcode in ASCII and 
in hexadecimal characters.  

If the content of the “Ascii” text box is changed the “Hex”-field is updated accordingly (and vice 
versa).  

Please note that TBarCode/SAPwin does not support all barcode parameters which are available 
in Barcode Studio. In such case the following ASCII-string is displayed: 

Not supported in SAPlpd version. Please contact TEC-IT 

In case of problems or questions please contact our support (sap@tec-it.com). 

 

� 
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10 FAQ 

If you have any questions, please refer to the following pages, check our website http://www.tec-
it.com/FAQ or contact our support team: support@tec-it.com. 

10.1 How to add the leading and trailing ‘*’ for Code 39? 

No action is required. The ‘*’s are added automatically to the barcode. 

10.2 How to add the check digit to Code 39? 

Simply select Modulo 43 (or another method) as check-digit method. The automatically computed 
check-digit is appended at the end of the barcode. 

10.3 How to add the leading and trailing ‘A’ (or B or C or D) for CODABAR? 

Enter A&A in the Format string (& is a placeholder for the barcode raw data). 

10.4 How to use a specific subset in Code 128? 

Use the corresponding barcode types Code128A, 128B or 128C. The whole code will be generated 
in the corresponding subset (if this is possible with the current input data. Otherwise Barcode 
Studio will change subsets as required). If you want to change the subset within the barcode enter 
A or B or C in the format string (please refer to 0). 

10.5 How to use the compressed mode of Code 128? 

Clear the format string in the barcode settings dialog (see section 7.3). If this field is empty (default) 
the code will be generated with the shortest possible representation automatically.  

10.6 How to use Application Identifiers (AI’s) in Code 128 or EAN128? 

Check (activate) “Translate Escape Sequences” and insert the following escape codes into the data 
text (see also 0):  

Control character Escape sequence Barcode type(s) 

FNC1 \210 Code 128, EAN128, UCC128 

FNC2 \211 Code 128, EAN128, UCC128 

FNC3 \212 Code 128, EAN128, UCC128 

FNC4 \213 Code 128, EAN128, UCC128 

FNC1 is the function number character and is used as field separator in connection with variable 
length data fields. 

► Application Identifiers (AI) are entered „as-is“ (unformatted) without parentheses, but the 
“human readable text” will appear formatted (incl. parentheses).  



 
 
 

Page 45 of 53 

 

Barcode Studio User Manual  

FNC1 must be appended to all application identifiers with variable length when the maximal length 
of the field in question was not filled completely and when it is not the last AI in the barcode. Do not 
append an FNC1 if there is a fixed length AI or it is the last AI! Please note that the correctness of 
FNC1 placements can be verified by Barcode Studio. 

10.7 What is the maximum data capacity of PDF417? 

The PDF417 specification defines the following limits (maximum data characters without error cor-
rection – PDF417_ECLevel = 0): 

Data Capacity 

Numerical data only 2710 digits. 

Bytes 1108 (also used for control characters to switch to lowercase letters). 

Text characters 1850 (only uppercase letters used [A..Z]). 

If you mix the character types the maximum data capacity cannot be predicted exactly (due to inter-
nal compression and character set switching). 

If you use a combination of digits and text (lower & uppercase letters) the maximum data capacity 
would be about 1100 to 1200 characters - but this can vary due to your input data. If you want to 
encode large data amounts we recommend using multiple symbols (or to use only capital letters). 

10.8 Escape-Sequences are not encoded (and the scanners signals an error) 

Escape sequences are starting with “\” and enable encoding of special characters. They are 
translated before the barcode is created. 

Escape sequences are only translated if the checkbox „Translate Escape Sequences“ is acti-
vated in the barcode settings dialog (see section 7.3).  
Otherwise you will find the original character sequence (e.g. „\t“) in your data and not the special 
character (in this case the TAB character). Some scanners do not “like“ the backslash – so you 
might encounter reading problems. 

10.9 How can I save the MaxiCode symbol with a higher image resolution? 

You have to set the “Module-Width” property to a higher value (as it is by default) – and increase 
the DPI resolution. 

Pay attention to the standardized size of MaxiCode. If you save MaxiCode as JPG-File you are able 
to adapt the horizontal and vertical dpi-resolution of the file to get the proper size. 

10.10 After saving the barcode to an image file, my barcode scanner cannot 
read the barcode! 

The bars and spaces in the symbol must have precise widths. By creating a bitmap image from the 
barcode, the widths are adapted to the matrix of the bitmap. Depending on its resolution more or 
less deviations can occur. The lower the resolution, the more differences in the width of bars/spaces 
will appear. 

Saving the bitmap with higher amount of pixels is a good method to avoid such problems. When 
using Barcode Studio with command line parameters, make sure that you use the option 
parameter “-o” to adapt the module width to full pixels. 
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10.10.1 Considering the module width and the bitmap resolution: 

If you save or print the barcode using a resolution of 300 dpi, one pixel will be 0,003333 inch = 
0,08466 mm wide. The module width should not be smaller than 0.19 mm for most symbologies. If 
you set the module width to a multiple of 0,08466 mm, you will achieve the best possible readability 
for the barcode (e.g. 3 * 0.08466 = 0,254 mms module width). By selecting a multiple of the width of 
a pixel the tolerances for the bars and spaces are minimized. 

If you have print ratios that are non integer ratios, you must use a number of pixels that can 
represent all module widths within the print ratio (e.g. you have a print ratio of 1:1.5 
 select 2 
pixels as for the module width 
 2 : 3 pixels = 1:1.5 print ratio = OK). 
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11 Licensing 

11.1 License Types 

Please check out http://www.tec-it.com/order for available license types and pricing. 

Single licenses are bound to exactly one machine. If you are interested in a single license, please 
tell us the so-called ”System ID” of the target computer. You can find the System ID in the licensing 
dialog (see below). 

11.2 Entering your License Data 

After receiving your license data, enter it into the license dialog. 

► Please enter the license data exactly as you received it from TEC-IT!   
Spacing and upper/lower case letters are to be considered. To avoid typographical errors, 
please insert the data using “copy and paste” from the email containing your license data 
whenever possible.  

 

11.2.1 License Dialog 

For entering the license data select Help ► License… from the menu. The following dialog will 
appear: 

 

�  This is the System ID of your Computer. 

 

Under ”Product” select “BC Studio 1D (standard)” 
or “BC Studio 2D (1D + 2D symbologies)”. 

 

In the field ”Licensee” enter the name that you 
entered as licensee at the time of your purchase (or 
the name that was assigned to you when the 
license key was forwarded). 

 

Under ”Kind of License” select the kind of license 
that you have purchased. You can select: 

   �    Single 

   �    Site 

   �    Developer 

 

Under ”Number of Licenses” enter the number of li-
censes that you have purchased. 

 

In the field ”Your license-key” enter the license key 
exactly as you received it from TEC-IT. 

 

� 
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12 Contact and Support Information 

 
TEC-IT Datenverarbeitung GmbH 
 

Address: Wagnerstr. 6  

AT-4400 Steyr  

Austria/Europe 

Phone: +43 / (0)7252 / 72 72 0 

Fax: +43 / (0)7252 / 72 72 0 – 77 

Email: office@tec-it.com 

Web: http://www.tec-it.com 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

AIX® is a registered trademark of IBM Corporation.  
HTML, DHTML, XML, XHTML are trademarks or registered trademarks of W3C, World Wide Web Consortium, Laboratory for Computer 
Science NE43-358, Massachusetts Institute of Technology, 545 Technology Square, Cambridge, MA 02139.  
JAVA® is a registered trademark of Sun Microsystems, Inc., 901 San Antonio Road, Palo Alto, CA 94303 USA.  
JAVASCRIPT® is a registered trademark of Sun Microsystems, Inc., used under license for technology invented and implemented by 
Netscape.  
Linux® is a registered trademark of Linus Torvalds in several countries. 
Microsoft®, Windows®, Microsoft Word®, Microsoft Excel® are registered trademarks of Microsoft Corporation.  
Navision is a registered trademark of Microsoft Business Solutions ApS in the United States and/or other countries. 
Oracle® is a registered trademark of Oracle Corporation. 
PCL® is a registered trademark of the Hewlett-Packard Company. 
PostScript® is a registered trademark of Adobe Systems Inc. 
SAP, SAP Logo, R/2, R/3, ABAP, SAPscript are trademarks or registered trademarks of SAP AG in Germany (and in several other countries).  
UNIX® is a registered trademark of The Open Group 
 
All other products mentioned are trademarks or registered trademarks of their respective companies. If any trademark on our web site or in this 
document is not marked as trademark (or registered trademark), we ask you to send us a short message (office@tec-it.com). 
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Appendix A: Barcodes 

A.1 Supported Barcodes 

Please refer to the additional document “Barcode Reference” available from www.tec-it.com. 

This document contains an overview of the supported barcodes, enumeration values (for develop-
ers using TBarCode OCX), the standard print ratio and the standard check digit methods. 

A.1.1 MaxiCode 

12.1.1.1 Extended Documentation 

For MaxiCode TEC-IT provides an extended documentation. Please refer to http://www.tec-
it.com/Download (Documentation) or use the online-version:  
http://www.tec-it.com/documentation/docu_maxicode_en.htm. 

12.1.1.2 Setting SCM parameters 

Please refer to the additional “Barcode Reference” available from www.tec-it.com. 

A.2 Check Digits 

The method for the check digit(s) calculation depends on the respective barcode type. A standard 
method for each barcode type is supplied. 

See section 7.3.1 for adjusting the check digit in Barcode Studio. 

For more information on check digits, please refer to the “Barcode Reference” available at www.tec-
it.com. 

A.3 Ratio, RatioHint (Ratio Format) 

The Print Ratio is the relationship between the widths of the bars and the widths ot the gaps of a 
barcode. Each barcode symbology should be generated with certain print ratios only. 

See section 7.3.6 for adjusting the print ratio in Barcode Studio. 

For more information on print ratios, please refer to the “Barcode Reference” available at www.tec-
it.com. 

A.4 Format 

Format is like a ”mask” for formatting the barcode data prior to encoding it (please do not mix up the 
Format with the Ratio Format). Placeholders in the specified format string can be mixed with 
constant data characters to build a final barcode data string. Also control characters are supported. 

See section 7.3.7 for adjusting the format string in Barcode Studio. 

For more information on format strings, please refer to the “Barcode Reference” available at 
www.tec-it.com. 
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A.5 Escape Sequences 

If you want to encode non-printable or special characters in a barcode, “Escape Sequences” must 
be used. They always start with a backslash (“\”) followed by the sequence. They can be use for 
encoding binary data (Bytes) too (if the symbology you are using offers this feature – e.g. PDF417 
or Data Matrix). 

See section 7.3.12 for enabling or disabling the translation of escape sequences in Barcode Stu-
dio. 

For more information on escape sequences, please refer to the “Barcode Reference” available at 
www.tec-it.com. 
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Appendix B: Error Messages 

The following errors may be displayed: 

Error Recommended Action 

Err OK = No Error  

Invalid parameter / unsupported value The current barcode type selected is not supported (most likely you 
have chosen “None”). Please select a barcode type. 

Wrong character You entered a character which cannot be encoded with the selected 
barcode symbology. Use another symbology or change your input 
data. 

Wrong number of input characters (needs xx 
chars)! 

You entered too much or too less characters for the selected barcode 
symbology. Use another symbology or correct the length of your input 
data. 

Input string too long The length of the input string is too long for Barcode Studio. 

Barcode does not fit into bounding rectangle The barcodes module width is too high for the current width (height) of 
the bounding rectangle. Either increase the width/height of the 
bounding rectangle or reduce the module width. 

No input characters Please enter some data to be encoded as barcode. 

Not supported Should not be displayed. Please contact TEC-IT. 

Not implemented (reserved for future use) This barcode symbology is not supported yet.  Please contact TEC-IT. 

Error in linear Component: No input characters. You are trying to generate a composite symbology. Please enter some 
data before the component delimiter ‘|’. 

Error in linear Component: Wrong character ‘x’ 
at position n! 

You are trying to generate a composite symbology. Please enter 
correct data before the component delimiter ‘|’. 

Error in linear Component: Invalid number of in-
put characters in combination with composite! 

When using UCC/EAN-128 as part of a composite symbology it must 
have a minimum amount of symbol characters (which is not equal to 
the amount of input characters). Please increase the number of input 
characters in the linear component. 

Error in linear Component: Wrong number of 
input characters (needs xx characters).  

You are trying to generate a composite symbology. Please enter the 
correct number of characters before the component delimiter ‘|’. 

Error in 2D Composite Component: No input 
characters. 

You are trying to generate a composite symbology. Please enter some 
data after the component delimiter ‘|’. 

Error in 2D Composite Component: Wrong 
character ‘x’ at position n! 

You are trying to generate a composite symbology. Please enter 
correct data after the component delimiter ‘|’. 

Increase barcode size. Resolution too low! The generated barcode is not readable by scanners. Please increase 
the width/height of the bounding rectangle. 

Table 3: Error Descriptions 
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Appendix C: Image Types 

Choosing File ► Export Image… the barcode can be converted to a bitmap or image format. The 
following image types are available. Please keep in mind that the barcode will become unreadable 
when producing a bitmap with very low resolution (does not apply for vector based image formats). 

Image 
Format 

Description Internal 
Format 

Color Printing 
Resolution 
included? 

BMP Microsoft Windows Bitmap. Bitmap b/w No 

EMF Enhanced Meta File Vector 
based 

color 
(RGB) 

Yes 

EPS Encapsulated PostScript. 

Newer releases of Barcode Studio are exporting a vector EPS 
format. V4.x used a bitmap based format. 

Vector 
based 

color 
(RGB) 

No 

E4C1 EPS file which uses the CMYK color space (4 color channels) in-
stead of RGB. 

Vector 
based 

color 
(CMYK) 

No 

E1C1 Grayscale EPS file which uses one channel (luminance) only. Vector 
based 

b/w No 

GIF Not supported because of license terms. Please contact us if you 
need more information. 

– – – 

JPG Joint Photographic Expert Group image file format. Bitmap b/w Yes 

PCX PiCture eXchange format. Bitmap b/w No 

PNG Portable Network Graphics. Bitmap b/w No 

TIF Tagged Image File. Bitmap b/w Yes 

Table 4: Image Data Formats 

 

                                                                 
1 Please note: E4C and E1C are no regular file extensions! They just serve for distinguishing between default EPS files 
(RGB) and EPS files in CMYK and Grayscale mode. 
Before using the exported file please change its file extension to .EPS! 
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Appendix D: Command Line Parameters 

The program can also be started at the command line. It supports various parameters which en-
ables the user to automate the barcode-generation process. 

D.1 Syntax 

1) bcstudio -d=datafile outputfile.ext [settingsfile.bcs] -h=height  

            {-w=width | -m=modulewidth} [-r=dpi] [-i=Orientation] [-o] 

2) bcstudio datafile outputfile.ext [settingsfile.bcs] -h=height  

            {-w=width | -m=modulewidth} [-r=dpi] [-i=Orientation] [-o] 

3) bcstudio [-? | -h | -help] 

-d=datafile Datafile can be *.txt, *.dat. 

You can also specify the datafile without using the prefix “–d=”. 

outputfile.ext Arbitrary filename when saving image-files. The filename extension (.ext) may be one of the 
following: JPG, TIF, BMP, PNG and PCX. 

The filename extension must be specified! 

settingsfile.bcs Settings-Files are *.bcs files which have been created with Barcode Studio. 

-h=height Height of symbol, measured in 1/1000mm. 

-w=width  
-m=modulewidth 

Width of symbol or module width; values are measured in 1/1000mm. 

E.g.: -w=50250 ... barcode is 50.25 mm wide 

-o Optimize resolution (adapt module width to pixel width) – recommended for low resolution 
devices. 

-i=Orientation Orientation of barcode (rotation in degrees), possible values = 0, 90, 180 and 270. Rotate 
barcode counter-clockwise. 

-r=dpi  Resolution of output file in dpi (default = 96 dpi). 

-? 
-h 
-help 

Display the help screen. 

D.2 Examples 

Generate Code128 (default), content=98765, size 50x30mm: 

bcstudio -d=”98765” barcode.bmp -w=50000 -h=30000 –o 

Generate a barcode image (JPG) with 300 dpi and 0.330 mm module width: 

bcstudio –d=”12345” barcode.jpg –h=30000 –m=330 –r=300 

Generate a barcode (symbology defined in bcs file) 70x30mm: 

bcstudio -d=”123” c:\pictures\bc.jpg bcsettings.bcs –w=70000 –h=30000 -o 

Generate a barcode with data from txt file: 

bcstudio data.txt barcode.tif barcode.bcs –w=70000 –h=30000 -o 

Generate a barcode with optimized readability and fixed module width: 

bcstudio -d=”ABCDE” barcode.bmp setting.bcs -h=30000 -m=265 –o 

Generate a barcode rotated 90° counter-clockwise: 

bcstudio -d=”12345” barcode.bmp –w=70000 –h=30000 –i=90 

 


